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Getting Started

Overview

The Mesa 3 Rugged Tablet™ from Juniper Systems has the
Windows 10 Pro or Windows 10 loT Enterprise operating
system. Standard features include a 7" display, capacitive
touchscreen, keypad, Bluetooth, and Wi-Fi. Standard
accessories include a lithium-ion battery pack, AC

wall charger, hand strap, connector port cover, fine tip
capacifive stylus and tether, and foam tip stylus for use

in wet conditions. Optional features include a GPS/GNSS
receiver, front and rear cameras, a 4G LTE data modem,
and a RS-232 port.

The Anatomy of the Mesa 3
Front and Back Features

1
5
2 6
2
FEACEORAZ
7
4 8 .
1 Notification LEDs 9 Rear Facing Camera Lens, 8 MP
2 Touchscreen and Display 10 Camera Flash
3 Protective Over-molded Bumper 11 Speaker
(all four edges) 12 Battery Door Lock
4 Microphone (one on each side) 13 Door to Removable Battery
5 Ambient Light Sensor Compartment and Card Slots
6 Front Facing Camera Lens, 2 MP 14 External Device Attachment
7 Keypad Point (1 of 3 on the back)
8 PowerKey 15 Location of Internal Battery

(not user accessible)
16 Storage Slot for Fine Tip Stylus
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Battery Compartment and Card Slots

aun hw

1 Battery Pack, Removable 4 Flexible Card Retainer

2 Battery Door 5 Battery Compartment

3 Micro SIM Card Slot and 6 Docking Connection
Micro SD/SDHC Card Slot 7 Hand Strap Attachment
(underneath card retainer) Point (2 on each side)

Connector Ports

8 Connector Port Protector
9 12VDC Power Input Jack
10 USB 3.0 Host, Full Size
11 Audio Jack
12 Storage Slot for Fine Tip Stylus

9 10 11 12
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Perform Initial Tasks
When you receive your Mesa 3, perform the tasks outlined in
this section before first use.

Review Documentation

This owner’'s manual and other documents like release notes
are available on our website at: https://junipersys.com/
support/mesa-3/documentation. View, download, and

print documents as desired, either on the Mesa 3 or another
computer with an internet connection. A PDF viewer is
included with your Mesa 3 apps.

Install and Charge the Battery Pack

The Mesa 3 comes with arechargeable and removable
Li-lon battery pack. Install and charge the battery pack as
follows:

1. The battery compartment is accessed from the back of
the tablet. Push the battery lock switch in, slide it to the
unlocked position, and remove the door.

CAUTION: The Mesa 3 is notf sealed against water and
dust when the battery door is not installed.

2. If you are using a micro SD card for additional memory
or a micro SIM card with the Cellular Data Modem
(optional), you can install them now before you install
the battery pack or at another time. If you do this,
make sure you replace the flexible card retainer before
installation of the battery. See Chapter 2, SD Cards or
Chapter 3, Install the SIM Card for details.

3. Follow the graphic on the battery label to insert the
battery pack properly.

TO ENSURE DOOR SEAL, INSERT SIDE (A) FIRST|
PARA VEDAR A PORTA, INSIRA O LADO (A) PRIME||
PARA SELLAR LA PUERTA, INSERTE PRIMERO LAD
ERST SEITE (A) EINLEGEN - SICHERT TURDICHTUN
P/ VEDAR A PORTA, INSIRA O LADO (A) PRIMEIR|

Hold the battery so that the black tab on the front edge
of the battery is up and facing the door latch (this fab
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helps you pull the battery out). Place the back edge
in first, gently pushing it underneath the two battery
catches. Rotate the front edge down until it is in position.

CAUTION: Do not insert the battery pack straight down.
Damage to the unit could occur.

Black Tab

4. Replace the door and press down on it until the latch
pops into the locked position.

5. Aftach the appropriate plug for your country into the
AC wall charger and plug it into a wall socket. Plug the
other end into the DC power jack on the Mesa 3.

Note: Use the AC wall charger that came with the Mesa
3 or another approved charger from Juniper Systems.

6. Charge the battery pack at room temperature (68°F or
20°C) for 6 hours (for the first charge). While the battery
pack is charging, the red LED blinks. When it is fully
charged and external power is applied, the red LED is
solid.

Note on optional internal battery: the Mesa 3 does not
recognize an internal battery until the Mesa 3 is being
charged.

Perform Set Up

The first fime the tablet is powered on, Windows setup
opftions are shown. Follow the prompts to set up your unit as
desired.

Chapter 1 Contents 5



Attach the Hand Strap and Stylus Tether
A hand strap, fine tip capacitive stylus, and tether are
included with the Mesa 3.

Hand Strap
To aftach the hand strap to the Mesa 3, follow the images
below. You can attach it to the right or left side of the tablet:

Stylus Tether
1. Aftach one end of the stylus tether to the stylus.

2. Push the free tether loop through one of the tether
atftachment points located on the side of any of the four
corners of the Mesa 3.

3. Insert the stylus with the attached tether through this
loop and tighten the loop.

4. Place the stylus into the stylus storage slot located on
the bottom of the Mesa 3.
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Standard Features

This chapter discusses the standard features included with
every model of the Mesa 3 Rugged Tablet™ with Windows
10 Pro or Windows 10 IoT Entferprise.

Display and Touchscreen

The Mesa 3 has a bright color display and capacitive
touchscreen with a diagonal viewing area of 7 inches
(178 mm).

Display and Touchscreen Profile Settings

Display Settings

To adjust the display setfings including the text size,
brightness, and orientation, go to the Action Center and
select All settings > System > Display.

Backlight Brightness
There are a few shortcuts to adjust the display backlight
brightness.

Open the Action Center. Tap the percent tile (sunicon) to
toggle the display backlight brightness up or down in 25%
increments from 0% to 100%. This same file can be accessed
by tapping the battery icon on the desktop. To simply dim
the backlight, tap the Battery saver tile. Tap it again to
return it fo the previous brightness.

Touchscreen Profile Settings

To adjust the touchscreen profile, go to the Start menu and
select Touchscreen Profiles. Select the touch profile you
want the screen optimized for: Finger and Stylus (defauli),
Finger, Stylus, Wet, or Glove. As the new profile loads, a
progress bar is shown. You can try different profiles to see
which one works best.

Using the Mesa 3 in Wet Conditions

When using the Mesa 3 in wet conditions, you must use
your finger or the soft-tipped stylus that is included on the
capacitive touchscreen and the Mesa must be held at a
minimum 30 degree angle, even if the Wet touchscreen
profile is selected. The hard-tipped stylus is not supported
with the Wet touchscreen profile. Third party styli may work
with the Mesa 3 fouch screen, however, performance may
vary.
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Calibration Tool - Do Not Use
If the Windows 10 screen calibration tool is used, it may
degrade touchscreen performance.

Keypad Features
The Mesa 3 has programmable keys, a power/suspend key,
windows key, entfer key, and a navigation pad.

The keys are sealed and have backlight illumination.

Key Function
o= | Windows Start screen
pl1 | Volume down (programmable)
p2 | Volume up (programmable)
< Move left
> Move right
A | Move up
V¥ [ Move down
& | Enfer (refurn)
p3 | Onscreen keyboard (programmable)
¢ |Power
= Press and release: On or sleep
= Hold for 5 seconds and pull down screen: Power
off.
» Hold for 20 seconds: Electrically disconnect the
battery pack(s); to reconnect the batteries, you
are required to plug in the charger or external 12
V power.

Chapter 2 Standard Features 9



Programmable Keys

To assign the programmable keys, open the Start menu and
select Keypad (located at the bottom of the Start menu
screen in a shortcut tile). The Keypad Buttons and Backlight
panel appears. The programmable keys and their current
assignments are shown. Select your preferred function per
key from the drop down menus.

Keypad Backlight Brightness

To adjust the keypad backlight brightness, go to the Start
menu and select Keypad. At the bottom of the Keypad
Buttons and Backlight panel is a slider that adjusts the
keypad backlight brightness. You can make the backlight
brighter by moving the slider to the right or turn it down by
moving the slider to the left. Dimming the keypad backlight
extends battery life when the Mesa 3 is in use.

LED Activity Indicators
LED activity indicators are located on the front of the Mesa
3in the upper-left corner.

s Red LED, solid: 1) When the Mesa 3 is put to sleep or
powered off by pressing the power key (M), the red LED is
solid until the unit has successfully completed the process,
and then the red LED turns off. If powering off the device,
do not remove the battery while the light is solid. 2) The
AC wall charger is plugged in and the battery is full (not
charging).

s Red LED, blinking: The AC wall charger is plugged in and
the bafttery is in the process of charging.

s Green LED, solid: Turns on when the system is booting,
programmable.

= Blue LED, solid or blinking: Programmable.

= Amber Light: Front or rear facing camera is in use.

The green and blue LEDs are in the same location. They
cannof be shown simultaneously. These LEDs can be
programmed by a developer. Sample code is available
upon request.
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Light Sensor

All units have an ambient light sensor located on the front
of the Mesa 3 in the upper-right corner. The light sensor
dynamically adjusts the backlight on the display.

You can disable this process and manually control the
display brightness if you prefer. Go to the Start menu

and select Settings > System > Display. Turn off Change
brightness automatically when lighting changes and tap
Apply. To manually adjust the display backlight, tap on
the battery icon at the bottom of the desktop screen. The
display backlight brightness can easily be toggled up or
down in 25% increments from 0% to 100% by tapping the
percent file (see the sunicon).

Connector Ports
The Mesa 3 has a 12 VDC power input jack, USB 3.0 Host
type A, and a 3.5 mm audio jack.

Connector Protector

The connector protector is removable and replaceable. To
remove it, pull it out of the ports, then gently pull the curved
rubber retainers out of the holes they are in. Replace it by
inserting the curved rubber retainers back into the holes.
See your sales representative if you need a new one.

Note: The connector protector is not required to maintain
the seal of the connectors or the tablet. The connector
protector is infended as a port dust cover.

SD Cards

The Mesa 3 has a slof for a micro SD card located in the
battery compartment. The card slot and flexible card
holder are designed to hold the card securely in place so it
will not come out or disconnect if the tablet is dropped. To
insert or remove a card, follow these steps:

1. Power off the tablet.

2. Remove the battery door as outlined in Chapter 1.

CAUTION: The Mesa 3 is not sealed against water and
dust when the battery pack and battery door are not
installed properly.

Chapter2 Standard Features 11



6.

CAUTION: Always power off the tablet before removing
the battery. Failure to do so may cause loss of data or
damage to the tablet. EXCEPTION: If your tablet has an
internal battery, this caution does not apply. You can
safely remove the removable battery while the unit is
running.

Remove the battery pack by pulling up on the black tab
on the battery pack.

An image on the battery compartment label shows the
correct location and orientation for the SD card (slot on
the right). Pull the flexible card holder back out of the
way. Push the card info the slof to insert it.

Flexible
Card Holder

SD Card
Slot

Push the flexible card holder back into place, covering
the card slots.

Replace the battery pack, and attach the battery door.

To remove the SD card, pull it out. Use tape or an eraser if
you have trouble.

Audio Features
The Mesa 3 has the following audio features:

Speaker - The speaker provides audible indicators
and program feedback. You can listen to mono audio
files and watch video. For stereo audio, use Bluetooth,
headphones or HDMI output from the optional dock.

Microphone - Use the microphones to record audio notes
or include sound in a video, using the camera (option).
Built in microphones can also be used for Skype calls.
Audio Jack - The audio jack supports a stereo headset

or headset/microphone combination with 3.5 mm
connections.
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Sensors

Compass, Accelerometer, and Gyroscope

The Mesa 3 has a built-in compass and accelerometer.

The accelerometer assists the compass in determining
direction, even when the device is not resting flat. The
gyroscope senses change in angular motion. The compass,
accelerometer, and gyroscope can also be used by other
user applications.

Compass Calibration
Periodic user calibrations help the compass function in the
environment the Mesa 3 is being used in.

1. Open an app that uses the compass.

2. Move the Mesa 3 around in the air so that it is oriented
in different directions and angles. An effective way to
assure this is properly done is to move the Mesa 3 back
and forth in a sideways figure 8 for approximately 30
seconds.

Bluetooth® Wireless Communication

The Mesa 3 has built-in Bluefooth® wireless technology,
allowing you to connect it fo other wireless devices with
Bluetooth technology.

Creating a Partnership/Pairing a Bluetooth Device
To create a partnership between the Mesa 3 and another
device with Bluetooth technology:

1. Turn both devices on.

2. Place them within a few feet of each other. (The Mesa
has long range Bluetooth, but the other device might
not.)
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3. Make Bluefooth discoverable on both devices. Bluetooth
on the Mesa 3 is off by default. To activate it, open the
Action Center and press and hold the Bluetooth icon.
Select Go to settings.

4. Inthe Bluetooth settings screen, you should see a list of
all Bluetooth devices within range. Tap on the name of
the device in the list you would like to pair with, then
tap Pair. If prompted, enter the PIN or pass code of
the paired device. You should now be paired with the
device.

Note: If Bluetooth is on and the tablet enters sleep or
hibernate mode, Bluetooth turns off to save battery power.
The connection is resumed once it powers back on.

Wi-Fi Wireless Networking
The Mesa 3 has built-in Wi-Fi wireless networking to connect
to the internet or an office network.

Connecting to a Wi-Fi Network

To use Wi-Fi, you need to be in range of a Wi-Fi access
point fo make a connection. When Wi-Fiis turned on (the
default), the Mesa 3 automatically starts scanning the area
for available Wi-Fi networks.

From the Action Center, click and hold the Wi-Fi network
icon, then select go to settings. A list of available networks
is shown. Select the network you want to use and enter
the network security key. The Mesa 3 remembers the Wi-Fi
network connections created.

Wi-Fi can be turned off and on and settings can be
managed from this set up screen.
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Power Management

The Mesa 3 runs on battery power, using a rechargeable, Li-
lon bafttery pack. A non-removable, internal battery pack is
an option.

Charging the Battery Pack(s)

For instructions on how to insert and charge the removable
battery pack, refer to Chapter 1, Install the Battery Pack.
For tablets that have both a removable battery pack and
an optional internal battery pack, the intelligent internal
battery charging circuit first charges the battery pack with
the least amount of energy. When this battery pack comes
to the same level as the other battery pack, then both
battery packs are charged at the same time unfil they are
both fully charged.

Battery packs are charged most efficiently af room
temperature (68°F or 20°C). They will not charge if it is too
hot or too cold.

@ CAUTION: Only use the battery charger that came with your
Mesa 3 fablet. The Mesa 3 requires a 30W or higher power
supply with a 12V output to power the tablet and charge
the batteries at the same time within the specified 4-6 hour
time frame. Anything less will not allow the tablet to operate
as specified.

Battery Status and Management

To find out how much battery life you have left, tap on

the battery icon at the bottom of the desktop screen. The
amount of charge left as a percent and the status of each
battery is shown. The cumulative amount of battery life left
forinstalled batteries and the approximate amount of fime
battery power will last is also shown. The amount of time left
varies depending on what you are doing with the unit.

Battery Life

Battery life on a full charge can be 12 hours or more. This
varies depending on whether or not you also have an
optional internal battery, the applications used, backlight
usage, and radio usage. The optional internal battery adds
5-6 extra hours of battery life.
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The shelf life for battery packs is about one year. The battery
packs should be recharged at least once per year. This
prevents the battery packs from discharging to a level that
might damage the batteries. Battery packs that are not
recharged at least every year, could fail to work or may
have reduced capacity. Battery packs typically last 1,000 to
3,000 charging cycles.

CAUTION: Only use batteries designed for the Mesa 3 from
an approved vendor. Use of non-approved batteries may
void your product warranty. The Mesa 3 must be refurned to
the factory for replacement of the optional internal battery.

@ CAUTION: The unit is not designed fo run on external power
without a battery installed. Doing so can damage internal
components of your unit and void the warranty.

Powering Off the Mesa 3

Short-term Storage

When you plug the tablet into the wall charger that comes
with it, the batteries are prevented from being overcharged.

Charge the Mesa 3 to 50-70% then power it off:

1. Press and hold the power button for 2-3 seconds.

2. A message is shown asking you to slide the screen down
to shut down your device.

Long-term Storage
To power off the Mesa 3 for long-term storage, follow these
steps:

1. Power off the Mesa 3 as described in the previous
section, Short-term Storage.

2. Press and hold the power button for 20 seconds. This
disconnects the batteries from the system.

3. Take out the removable battery and store it in a cool,
dry location.

4. When you are ready to power on the Mesa 3, replace
the battery pack. Plug in the AC wall charger and
connect it to the Mesa 3 BEFORE you power it on.
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Ctrl-Alt-Delete Function

Press and hold down the windows key, then press the power
key. A list that includes the Task Manager is shown. Select
Task Manager to see which apps are running. Press More
details at the bottom to view Processes, Performance, and
other items. This can be useful for troubleshooting.

Mesa 3 is Locked Up

If the Mesa 3 is completely stuck and won't respond or you
cannot get to the Start menu, hold the power key down for
five seconds to see if that solves it. If that doesn’'t work, hold
it down for 10 seconds. This causes a hardware shut off. Press
the power button again to power it on.

If 10 seconds doesn’t work, hold the power button down for
20 seconds. Batteries are forced to electrically disconnect
from the tablet, causing a complete shut down. The tablet
cannot be powered on again until it is plugged in with the
AC wall charger. Keep this in mind if you are in the field.

CAUTION: Holding the power button down for 20 seconds
for a forced disconnect is recommended only as a last
resort. Forcing the power off causes all unsaved data to be
lost and corrupts active data transfers to storage.
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Optional Features and Accessories
This chapter discusses the optional features that can be
included with the Mesa 3 Rugged Tablet.

Note: The RS-232 connector is not available in combination
with the barcode imager or the RFID reader. The NEO-M8T
GNSS receiver with external antenna is not available in
combination with the barcode imager or the RFID reader.

GPS/GNSS

Mesa 3 Geo models use an infegrated GPS/GNSS receiver
with an intfernal antenna to provide position information.
Use Maps to see your location and ensure that the receiver
is working. Open the Start menu and select Maps.

u-blox NEO-M8T GNSS Receiver

The u-blox NEO-MS8T with an external antenna port is
available as an upgrade option for GPS/GNSS in Mesa

3 Geo models. The NEO-M8T can collect data for post
processing. When connected to an external GNSS antenna,
the GPS/GNSS receiver will automatically detect and use
the external antenna. Otherwise, the GNSS receiver will use
the internal GNSS antenna.

GPS/GNSS Support

Integrated GPS/GNSS Support in Windows

The Windows operating system provides built-in support for
GPS/GNSS devices. As part of that support, the Windows
Sensor and Location platform provides a standard way

for GPS/GNSS information to be made available fo
applications that have been designed using the Windows
Sensor and Locatfion application programming interfaces
(APIs).

Legacy Support

In addition to the Sensor and Location APIs, legacy
applications that require access to a serial port can access
NMEA data through a serial COM port interface. The name
of the COM port can be found by using Device Manager
and looking under Ports (COM & LPT) for “u-blox Virtual
COM port (COMXx) where “x" is the port number allocated
on your device.
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Configuring the GNSS Receiver
The u-blox u-center utility can configure the internal u-blox
GPS/GNSS receiver.

1. With your Mesa 3, download and install the latest version
of u-center from the u-blox website.

2. Find the COM port number for the Mesa 3.
a. Open Device Manager.

b. Expand the selection for “Ports (COM & LPT).” Find
the u-blox COM port.

& Device Manager

File Action View Help
@ 5 5 B

iy Audio inputs and outputs
@ Batteries
9 Bluetooth
a Computer
ws Disk drives
[ Display adapters
i Firmware
7 Human Interface Devices
1% Imaging devices
— Keyboards
EH Monitors
P Network adapters
« § Ports (COM & LPT)
———O @ u-blox Virtual COM Port (COM7)
§ Virtual Port (COM4)
i@ Virtual Port (COMS)
@ Virtual Port (COM6)
™ Print queues
I} processors
B <D hoct adantere

3. Open u-center.

4. Tap the arrow next fo the plug icon. Select the COM
Port that was identified in Step 2.

G u-center 21,02 G COMS3 - u-center 21.04
File Edit View Playen File Edit Wiew Player
LE =~ LE =~

A MU w | e i - v v | A
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Change the SBAS and Rate Settings

SBAS settings specify which SBAS satellites the receiver

should use for GPS correction.

Rate is the amount of time it takes to update the position

and output the data to the device.
To change the SBAS and Rate Settings,

1. Select View > Configuration View.

2. In the left column scroll down and select your desired

setting.
= SBAS (SBAS Settings)
= RATE (Rates)

lo COM4 - u-center 20.10 - [Configure - SBAS Settings]
P File Edit View Player Receiver Tools Window Help

O &~ 2 aaaEBEDEDE-EAE-
LR RIS - N oA b
v lc 3 & & &

. f"" o “ | UBX- CFG (Config) - SBAS (SBAS Settings)

Subsystem |Enabled o

PAN Codes

© WaAS

¢ EGNOS

™ Allow test mode use [Msg 0)

Services [V Ranging (Use SBAS in NAV)
IV Apply SBAS Comection data
[ Apply integrity information

Number of search channels |3 =

b COM4 - u-center 20.10 - [Configure - Rates]
B File Edit View Player Receiver Tools Window Help

bivid @& @

DR~ |&0 ® Q@2 DD OO-@-m
PUETEEY 21 o> -n —

NF (Inf Messages) ~ ]
TFM (Ja { - UBX - CFG [Config) - RATE (Rates)
FM (Jamming/Interference Monito

Time Source ,m
Measurement Period 'W [ms]
Measurement Frequency m [Hz]
Iter) Navigation Rate l—l [exe]
Navigation Frequency m [Hz]
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Change the Navigation Mode
Navigation mode helps to compensate for how fast the
device is moving.

1. Select View > Configuration View.

2. Inthe column on the left, scroll down to tap on NAV5
(Navigation 5).

3. Under Navigation Modes, use the drop-down menu to
change the Dynamic Model to your preferred mode.

[@ com4 - u-center 20.10 - [Configure - Navigation 51
D File Edit View Player Receiver Tools Window Help

DE &~ @ B8 EBEDEO0-RA-E-m- 33

& [ R I,

UBX - CFG [Config) - NAVS (Navigation 5)

Navigation Modes

Dynamic Model |3 - Pedestrian M
. 0 Portable
ke

3 - Pedestiian
UTC Standard 4+ Automictive

8- Aibome < 4g
9 - Whist
Navigation Input {10 - Bike

Min SV Elevation 5 [dea]
C/NO Thieshold [0 msva

0 [dbHz]
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Change the Baud Rate

The baud rate determines the speed of the data
fransmission.

Auto detect automatically determines the baud rate you
need. To turn off auto detect,

1. Select Receiver > Action.
2. Uncheck Auto Detect.

[@ coma - u-center 20.10 - (viap)
D File Edit View Player | Receiver Tools Window Help

D& - &R

Connection

E-B-E-m- 38

LR TR N

Wiwie R &%
No online map image -
You do not have a Gooc
Enter a valid key intc

Tools->Preferences.

Get a Google Map API }
https://developers

Baudrate

NTRIP Server/Caster...
NTRIP Client...
Autobauding

Debug Messages
Generation

Protocol Filter

static-maps/?hl=en

Action > Hotstart

Differential GNSS Interface. Warmstart

Epoch detection... Coldstart
Save Config
Load Config
Revert Config

Auto Detect

Get Information

To manually change the baud rate,

1. Select Receiver > Baud rate.
2. Choose your preferred baud rate.

B COM4 - u-center 20.10 - [Map]

D File Edit View Player Receiver Tools Window Help
D=~ &R Connection =Rl -Rd R4 Ral- 1|
. Baudraty > 1200
PRSI — ‘
P E R ey S s
H Jiw §C g
S NTRIP Client... o
Mo online map image - + 9500
Vou do not have a Gooc Autobauding -
Enter a valid key intc 19200
Tools->Preferences, Debug Messages 38400
Get a Google Map API } Genesation 57'600
https:/~/developers =en
Protocol Filter > 115200
Action > 230400
Differential GNSS Interface... 460'800
Epoch detection... 921'600
Custom
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View the Text Console
The Text Console shows the messages being sent to the
GNSS receiver. To get o this screen,

1. Select View > Text Console.

[ Y —) -~ o0 x
D Fie Edit View Player Receiver Took Window Help

DEHES- &0y B & AR B0 ED0-E-E-M- 6 aonssnsoes

- R A . - » —

09,56, 311, 35,16, 58,084, 34,22,16,178,25777
11125,26)31,02,067, 46,38, 265, 36°7.

2,145,36,73,21,039,27°65
41010112452

5 NIR chens Not comecied Cor Vs e COMIS00 Nofieapen A 003422 1518 8 |

GPS/GNSS Accuracy

The GPS/GNSS antenna in the Mesa 3 is at the top under the
notification LEDs. It is intended to work in both portrait and
landscape view. Do not put your hand or another object
over this area. Accuracy could be reduced. The more items
between the antenna and the satellites, the lower the
accuracy.

Camera
The Mesa 3 has an optional front facing camera that is 2 MP
and a rear facing camera that is 8 MP.

You can capture both stillimages and videos using the
camera application. Other options include a timer, flash,
and brightness settings.

Photo and Video Library
Photographs and videos are automatically stored in the
Pictures folder.
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4G LTE Data Modem
The 4G LTE data modem is an option for the Mesa 3, adding
Wireless Wide Area Network data modem capability.

This modem supports all major service providers in North
America, Europe, and many other regions of the world.

Set up a Data Account with a Wireless Provider

Contact a wireless provider to set up data service for the
cellular data modem and obtain an account and micro SIM
card. You need to provide the following information when
setting up an account:

1. Billing Information and business ID, such as your Federal
Tax ID or VAT number.

2. The wireless services required. Specify that you need
data service only. You do not need voice or messaging
services.

3. You may be asked for the modem’s IMEI number. From
the Start menu, select Settings > Network & Internet >
Cellular. Tap on the Cellularicon, then select Advanced
Options. The IMElI number is listed under Properties.

Install the SIM Card

The card slot and flexible card holder are designed to
hold the card securely in place so it will not come out or
disconnect if the tablet is dropped. To insert or remove a
card, follow these steps:

1. You must power off the tablet.

2. Remove the battery door as outlined in Chapter 1.

CAUTION: The Mesa 3 is not sealed against water and
dust when the battery door is not installed properly.

3. Remove the battery pack by pulling up on the black tab
on the front of the battery pack.
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4. Animage on the battery compartment label shows the
correct location and orientation for the SIM card (slot
on the left). Pull the flexible card holder back out of the
way. Push the card into the slot to insert it.

Flexible
Card Holder

5. Push the flexible card holder back into place, covering
the card slots.

6. Replace the battery pack, and attach the battery door.

To remove the SIM card, gently pull it out with tweezers or a
piece of tape.

Note: If the modem was on before shutfing the Mesa 3
down to insert the SIM card, you are prompted fo configure
the data connection when you reboot.

Barcode Imager

The Mesa 3 Rugged Tablet with a barcode imager allows
you to read 1D and 2D barcodes and easily import barcode
data into custom or standard programs running on the
Mesa 3.

Barcode Connector Utility
The Barcode Connector™ utility is a barcode wedge
program provided with the barcode imager.
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Home Screen

When the Barcode Connector utility loads, the home screen
appears. From the home screen, you can do a Scan Test
right away. Aim the imager towards a barcode. Tap Scan
on the screen or press the scan button on the keypad (p2

is the default). When a red aiming LED appears, place it

on or near the barcode. After a successful scan, the Scan
Symbology Type and Scan Data are shown on the screen.

Barcode Menu

Select the menu symbol in the upper left hand corner of the
home screen or swipe the screen from left to right to see the
menu (you can do this from any screen in the application).
This menu gives you access to several setting screens.

User Settings

From the menu, select User to open the User Setfings screen.
From this screen, set up options like Barcode Scan Time and
which button fo use fo scan barcodes.

Barcode Scan Time

30s
Reep on good read
Beep on bad read

N | o Method
® Use copy / paste buffer
U/E O Use individual keystiokes

) Description

Keyboard Wedge Method
(9 ® Use Virtual-Key Codes
D Use Unicode Characters
PC (© pesaiption
2D Select Scan Button:
o |
Picklist Mode
(] nabe Pickiist Mode
(¥) Description
Enhanced LCD Screen Scanning
Cnable Cnhanced LCD Screen
Scanning
Scan Consecutive Read Level
Consecutive Read Level
1 [£]
() Description
Reset to Default Barcode Settings
Reset Scttings
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Data Format and Barcode Types
On the Data Format screen, you can set up a prefix and
suffix.

Use the rest of the menu options to set up different types
of barcodes, including 1D code types, composite Codes,
postal codes, and 2D code types.

Reading a Tag
Now that the Barcode Connector utility is set up, you can
start scanning barcodes.

1. Minimize the Barcode Connector utility.

2. Open an application or document to receive the
barcode data and put the cursor where you want the
data to be placed.

3. The barcode imager is located on the top of the Mesa 3
when in portrait mode. Aim the barcode imager at the
barcode.

4. The distance required between the barcode and Mesa
3 varies depending on the barcode being read. There
is a red aiming LED that helps you aim af the correct
barcode. Press the scan button. When the barcode is
successfully scanned, the barcode information is placed
in your document.

Troubleshooting the Barcode Imager

If the barcode imager is not functioning correctly, you can
set it to factory default settings. Follow these steps:

1. Launch Barcode Connector.

2. Scan the Set Factory Default barcode, shown here.
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3. Use the Reset Settings button on the User page of
the Barcode Connector to restore the settings of the
Barcode Connector program.

4. Close the Barcode Connector program.

5. Launch Barcode Connector and verify that correct
functionality has been restored.

Sample Barcodes

1D Barcodes
* 123450789
Code 39
Juniper Systems, Inc,
Code 128
0 ‘ 001234 5678058 H
UPC-A
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2D Barcodes

Aztec

Maxicode

et

MicroPDF417
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Pistol Grip

The Pistol Grip is designed to reduce strain and maximize
productivity in heavy barcode scanning applicafions. It
meets MIL-STD-810C.

Note: Pistol grip compatibility requires that the Mesa 3 is
configured with the electrical contacts on the case back.

How to Use the Pistol Grip
1. Place the Mesa 3 with the back facing up.

2. Line up the three screw holes and contacts on the Pistol
Grip with these items on the Mesa 3.

3. Use the three screws included with the Pistol Grip to
aftach it to the Mesa 3.

4. Use the Barcode Connector software discussed earlier
in this chapter as described.

5. The trigger has two stages. Pull it halfway back to
turn the laser on and aim the barcode imager atf the
barcode. Pull it back fully to read the barcode.

Note: It is not compatible with the RFID reader.
Holster

There is an optional nylon holster for this system that you can
attach to a belt or shoulder strap.
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RFID Reader

The Mesa 3 Rugged Tablet with an RFID reader allows you
to read UHF RFID tags and easily import data info custom or
standard programs running on the Mesa 3.

RFID Connector
The RFID Connector™ utility is a program provided with the
RFID reader.

Home Screen

When the RFID Connector utility loads, the home screen
appears. From the home screen, you can do a Scan Test
right away. Hold the Mesa 3 with the display facing you,
and an RFID tag directly away from the back of the Mesa 3.
Tap Scan on the screen. After a tag is successfully read, the
Scan Data is shown on the screen.

RFID Connector Menu

Select the menu symbol in the upper left hand corner of the
home screen or swipe the screen from left to right to see the
menu (you can do this from any screen in the application).
This menu gives you access to User and Data Format setting
screens.
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User Settings

From the menu, select User to open the User Settings screen.
From this screen, set up options like RFID Scan Time and
which button to use to scan RFID tags.

JUNIPER’

General
Beep when scanning duning Off lime
seep on good read
Beep on bac read

Copy Method

IO M

@ Use copy / paste buffer

O Use individual keystrokes

() Description

Keyboard Wedge Method
@ Use Virtual-Key Codes

O Use Unicare Characters

() Description

Select Scan Button:

] =

Tag Type
O Genz
® AIA

Scan Time and Power Level

Scan Time:

30s

Power Level

30 dBm

Worst Case Off Time: 0.0's

() Description

34 Mesa 3 Rugged Tablet Owner’s Manuall



Options

Scan Time: determines the maximum time to attempt
to scan for before giving up. When the scan button is
pushed, the RFID scans until it finds a tag or until this
amount of time has elapsed.

Power Level: Sets the power level of the module.

Worst Case Off Time: If the power is set higher than the
regulatory threshold, this shows the maximum amount
of time that the radio will remain off before it will allow
another scan. The Mesa 3 regulatory threshold is the
same as the maximum power of the RFID module so this
number will always be zero.

Select Scan Button: Allows you to select from P1, P2, or
P3 as the RFID scan button. While the RFID application is
running, these override what is specified in the Keypad
Control Panel. If the RFID Connector has P1 set as the
scan button, the Keypad Control Panel will show P1

as blank. This should not be changed from within the
Keypad Control Panel while the RFID Connector is
running. Once the RFID Connector closes, the scan
button reverts back to what it was just before the RFID
Connector launched.

Beep on good/bad read: A sound plays when a tag is
read. A different sound plays when the time has elapsed
and no tag was read.

Startup RFID Connector on bootup: The RFID Connector
software will automatically start when the device boots.

Startup RFID Connector Minimized: The RFID Connector
software will automatically be minimized when it is
started.

Use copy/paste buffer: When this is setf, the RFID data
(sometimes including prefix/suffix data) is placed in the
copy buffer, and then a “Citrl-V" is simulated to paste the
data wherever the user has focus.

Caution: The data is left in the copy buffer, so if sensitive
data is being scanned, use “individual keystrokes”. This
method is much more snappy.

Use individual keystrokes: When this is set, every character

(including prefix/suffix data) is sent as individual
keystrokes.
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= Scan option: This is a way to test your setup. When
pressed, the Scan Data box is cleared and an RFID scan
is inifiafed. An alternative is to put the cursor in the Scan
Data box, and then press the button that is assigned as
the scan button (P1, P2, or P3).

Reading a Tag

Open a document to receive the tag data and put a
cursor in the proper location. For best read performance,
hold the Mesa 3 with the display facing you, and the tag
directly away from the back of the Mesa 3. The RFID reader
is infernal and roughly 2" to the right of the camera when
looking atf the back of the Mesa 3. The best orientation is
portrait or landscape with Mesa 3 orthogonal or normal to
the tag.

The distance required between the tag and Mesa 3 varies
depending on the tag. This is not a long range reader, so
you may need to be as close as a few inches and may be
as far as 3 feet from the tag.

Antenna for RFID Reader

The antenna is a circularly polarized antenna. This has
reduced range, but allows the Mesa 3 to be held in any
orientation (linear antennas can have longer range if held
in the right orientation).

RS-232 Port

An RS-232 9-Pin D-Sub connector is an option for the Mesa
3. Depending on the factory configuration, it will provide
either 5 VDC or 12 VDC on pin 9.

There is a RS-232 Control Panel to configure the behavior of
the RS-232 port. There is a link to it on the desktop.
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When you open the RS-232 Control Panel, the default
configuration is shown:

RS232 Settings — >

Enable R5232 port (COMT)

Configure R5232 signals

® Always enabled

() Disabled during sleep

Configure pin 9 as input or 3 volt power supply
® Input
) Power supply enabled

) DTR enables power supply

Disable power supply during sleep

| OK || Cancel | Apply

The options can be edited to suit your application:

s Enable RS-232 port: When it is unchecked, it powers
down. When this option is checked, it powers up the RS-
232 hardware. It then displays the assigned COM port
number.

Nofte: If you do not have a device plugged info the RS-
232 port, the port pins corrode more quickly when left
powered up. Use the setting to power down when it is not
going fo be used.

Note: Power consumption during sleep is higher when the
RS-232 hardware is powered up.

» Configure RS-232 Signals: Select Always enabled to
have the RS-232 output signals driving and input signals
enabled when the Mesa 3 is running or in sleep mode.
Select Disabled during sleep to have the RS-232 output
and input signals disabled automatically when the
tablet is in sleep mode. If your app and/or RS-232 device
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experiences communication failures when tablet enters
or exifs sleep mode, then do not use this option.

Configure pin 9 as input or power supply: Pin 9 is the Ring-
In signal input. It is rarely used by devices anymore and
has become a popular pin to provide a power source to
an RS-232 device.

Select Input if your device uses Ring-In signal or if it does
not need fo be powered from the RS-232 port.

Select Power supply enabled fo make pin 9 a power
supply to be used by the RS-232 device. The power supply
is enabled automatically without needing any interaction
with the COM port. Depending on the model, the power
supply supplies either 5 VDC or 12 VDC.

» Select DIR enables power supply to make pin 9 a power
supply (5 VDC or 12 VDC depending on model). The
power supply remains off until the user application opens
the COM port and asserts the DIR signal. When the DIR
signal de-asserts, the power supply turns off again.

» Check Disable power supply during sleep to cause the
power supply to automatically turn off when the tablet
is in sleep mode. This can allow the RS-232 device to
conserve battery power in sleep mode. If your app and/
or RS-232 device experiences communication failures
when the Mesa 3 enters or exits sleep mode, then leave
this opfion unchecked.
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Office Docking Station

The Office Docking Station enables you to perform the
following functions:

s Charge your Mesa 3 Rugged Tablet

= Use your Mesa 3 as a desktop computer

» Transfer data to or from another computer or network via
the Ethernet connection

Dock Features
12 3

Lock Latch (2)
Alignment Pin (2)
Back Rest

Release Button

Pogo Pins

USB Ports, Host (3)
HDMI Port
Ethernet Port

W ® N & 1 A W N =

Power Input Jack

Ports
= The USB ports are for attaching devices to the Mesa 3
such as a mouse, keyboard, or external storage device.

= The HDMI port is for connecting a video monitor to the
Mesa 3, giving you a second monitor.

= The Ethernet port is used for networking (an Ethernet
cable is not included).
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How to Use the Dock

1.

Provide power to the dock using the 30 W AC wall
charger provided with your Mesa 3. A 45 W charger

is available as an opfion, and we recommend this
charger if you are using the dock as an office computer
with several peripheral functions. The 30 W AC wall
charger might not provide enough power to charge the
batteries and run the Mesa 3.

Plug in the cables for your desired setup.

If a hand strap is covering the pin contacts on the Mesa
3. unhook one end orremove it.

Hold the Mesa 3 horizontally with the docking pin
contacts facing down. Place it over the dock alignment
pins and press down until you feel and hear the lock
engage.

The Mesa 3 charges more quickly if the power settings
are set up to allow the Mesa 3 to enter a low power
mode when it is not in use, but is plugged in. To adjust
this setting, go to the Start menu, then Settings > System
> Power & sleep.

Mounting the Dock to a Surface

The Office Docking Station is freestanding. It can also be
mounted to a surface like a desk or shelf. There are keyhole
slots on the bottom for this purpose.

4" (101.5 mm)

175" (4.445 mm)
125" (3.175 mm)
.350” (8.89 mm)
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Ethernet Specifications

10/100/1000 Mbps twisted-pair Ethernet

IEEE802.3/802.3u/802.3ab 10BASE-T, 100BASE-TX, and
T000BASE-T

Manages twisted pair crossover detection and correction

Full-duplex and half-duplex capability (only full-duplex
operation af 1000 Mbps)

Maintenance and Environmental Issues

The dock is inftended for indoor use only.
Temperatures should be between 0°C to 50°C.

Avoid using the dock in situations where water can enter
the connector ports. It is not sealed against water and
must be kept dry.

Do nof touch the docking pins (spring loaded contacts)
with conductive items when power is applied to the
dock.

Do notf drop items on the dock that can damage the
pins.

Keep debiris off of the docking pins.

Vehicle Dock

The Vehicle Dock is part of a mounting system that provides
the Mesa 3 with a method to be secured in a vehicle or
other mobile mounting application.

Note: There is a powered version and a non-powered
version.

Chapter 3 Optional Features and Accessories 41



Vehicle Dock Features:
= A locking mechanism with a unique key (duplicates can
be made for fleets)

» Powered dock: 12 VDC power port, vehicle charger, and
USB 2.0 port (host)

= Four holes and screws for attachment fo a mounting
system (details follow)

Mounting System

The Vehicle Dock does not attach directly to a vehicle.

The dock attaches to any 30 mm x 38 mm AMPS mounting
system that suits your application (sold separately). We
recommend products from RAM Mounts (rammount.com) or
ProClip (proclipusa.com).

How to Use the Dock

1. Aftach the mounting system to the vehicle. Plug the 12
V charging cable into the vehicle power port, and then
info the dock.

2. If ahand strap is covering the pin contacts on the Mesa
3, unhook one end orremove it.

3. Hold the Mesa 3 horizontally with the docking pin
contacts facing down. Place it over the dock alignment
pins and press down until you feel and hear the lock
engage.

4. Press the lock bar down unfil it engages the Mesa 3.

5. Push the lock button in. The Mesa 3 is now locked in the
dock and cannot be accidentally removed.

6. Toremove the Mesa 3, turn the key until the lock button
pops out. Liff the lock bar, and remove the Mesa 3.
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Battery Charger
The Battery Charger is an optional accessory, allowing you
to charge spare battery packs for the Mesa 3.

How to Use the Battery Charger

Batteries charge best at room temperature (about 68°F or
20°C). Batteries will not charge (or might charge slowly) at
temperatures below 32°F (0°C) or above 122°F (50°C).

Power the Battery Charger by using the AC wall charger
provided with your Mesa 3. Slide the battery pack into the
battery charger, orienting it so that the battery contacts
meet the charging contacts in the battery charger. The
red LED flashes slowly, indicating that the battery pack is
charging.

LED Indicator

The LED indicates the charging status:

= Solid, on: The battery packis fully charged.

= Blinking (slow): The battery pack is charging.

n Off: There is no power. The battery is not charging.
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Storage, Maintenance, and Recycling
Follow the instructions in this chapter to properly maintain
and recycle the Mesa 3.

Storing the Mesa 3 and Battery Pack

When the tablet is not being charged and is in a sleep state,

it draws a small amount of power. This power draw is used to
maintain the memory (RAM) of the tablet in the same state it
was in when it was awake. We recommend charging the tablet
each night or weekend when it is in a sleep state.

If the Mesa 3 is not charged while in a sleep state and the
battery reaches a low charge, it automatically hibernates to
prevent further drain on the battery.

Note: Data and programs are secure as long as they have
been saved, even if the battery pack becomes discharged.
The tablet does not depend on the battery to store the data
for extended periods.

Storing the Mesa 3 for More than Two Weeks

To store the tablet for two weeks or more, complete the
following steps:

Charge the battery pack 30 to 50 percent.

Close all running programs, and furn off the tablet.
Remove the battery pack.

If you have an internal battery pack, press and hold the
power button for 20 seconds to disconnect it.

Place the battery packin a cool, dry location.

The AC wall charger must be plugged in and
connected to the Mesa 3 in order to turn it on after
storage.

R

Protecting the Touchscreen

Protect the touchscreen from impact, pressure, or abrasive
substances that could damage it. To further protect the
touchscreen, apply a screen protector (opfional accessory)
using the directions that come with it in the package.

CAUTION: Be sure to replace the screen protector as often
as the screen protector instructions recommend.
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Cleaning the Mesa 3

Make sure the battery door is securely installed. Remove
the screen protector if you want to clean underneath if.
Use warm water, a mild cleaning solution, and a soft bristle
brush to gently clean the Mesa 3.

@ CAUTION: Do noft direct a high-pressure stream of water
at the device to clean it. This action could break the seal,
causing water to get inside the device and voiding the
warranty.

CAUTION: Exposure to some cleaning solufions may
damage your device, including automotive brake cleaner,
isopropyl alcohol, carburetor cleaner, and similar solutions.
If you are uncertain about the strength or effect of a
cleaner, apply a small amount to a less visible location as a
test. If any visual change becomes apparent, promptly rinse
and wash with a known mild cleaning solution or with water.

Recycling the Mesa 3 and Batteries

When the Mesa 3 and Li-lon battery packs for your Mesa
3 reach the end of their service life, they must not be
disposed of with municipal waste. It is your responsibility
to dispose of your waste equipment by handing it over to
a designated collection point for the recycling of waste
electrical and electronic equipment.
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Warranty and Repair Information

Limited Product Warranty

Two Year Warranty

Juniper Systems, Inc. (*JS") warrants that the Mesa 3
Rugged Tablet and optional internal battery shall be free
from defects in materials and workmanship, under normal
intended use, for a period of 24 months from the datfe of
shipment, excepting that this warranty shall not apply to
user replaceable battery packs, media containing tablet
and desktop PC programs, user documentation, and any
accessories.

Ninety Day Warranty

JS warrants that the following items shall be free from
defects in materials and workmanship, under normal
intended use, for a period of ninety (90) days from the date
of shipment:

= Userreplaceable battery packs

s User documentation
= Accessories

Warranty Exclusions
This warranty shall not apply if:

(i)  the product has been set up improperly or has been
improperly installed or calibrated,

(i) the productis operated in a manner that is not in
accordance with the user documentation,

(iii) the product is used for a purpose other than for which it
was designed,

(iv) the product has been used in environmental conditions
outside of those specified for the product,

(v) the product has been subject to any modification,
alteration, or change by or on behalf of customer
(except and unless modified, changed or altered by JS
or under direct supervision of JS),
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(vi) the defect or malfunction results from misuse or
accident,

(vii) the serial number on the product has been tampered
with or removed, or

(viii) the product has been opened or tampered with in any
way (such as the tamper evident VOID label indicating
certified IP [Ingress Protection] seal area has been
tampered with or removed).

Parts that are excessively worn are not covered under
warranty. These may include, but are not limited fo, the
keyboard elastomer and switch matrix, hand straps, and
the touch screen (if applicable).

This warranty is exclusive and JS will not assume and hereby
expressly disclaims any further warranties, whether express
or implied, including, without limitation, any warranty as

to merchantability, fitness for a particular purpose, non-
infringement or any warranties arising from the course of
performance, dealing, or usage of trade. JS specifically
makes no warranties as to the suitability of its products for
any particular application. JS makes no warranties that

= its products will meet your requirements or will work in
combination with any hardware or applications software
products provided by third parties,

» the operation of its products will be uninterrupted or error
free, or

» all defects in the product will be corrected.

JS shall not be responsible for software, firmware, information,
or memory data contained in, stored on, or infegrated with
any products returned to JS for repair, whether under warranty
or not.

Remedy

In the event a defect in materials or workmanship is
discovered and reported to JS within the specified warranty
period, after evaluation by a technician at a certified repair
center, JS will, at its option, repair the defect or replace the
defective part or product. Replacement products may be
new or recondifioned. JS warrants any replaced or repaired
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product for a period of ninety (?0) days from the date of
return shipment, or through the end of the original warranty
period, whichever is longer.

Limitation of Liability

To the fullest extent allowed by law, the obligation of JS
shall be limited to the repair or replacement of the product.
JS shallin no event be liable for special, incidental, or
consequential, indirect, special or punitive damages of any
kind, or for loss of revenue or profits, loss of business, loss of
information or data, or other financial loss arising out of or
in connection with the sale, installation, maintenance, use,
performance, failure, or interruption of any product. Any
responsibility and/or liability of JS shall, in connection with a
warranted product, be limited in the maximum amount to
the original purchase price.

Governing Law

This warranty is governed by the laws of Utah, U.S.A. and
excludes the United Nations Convention on Contracts for
the International Sale of Goods. The courts of Utah shall
have exclusive personal jurisdiction in case of any disputes
arising out of or in connection with this warranty.

Warranty Repairs

Warranty information for the Mesa 3 Rugged Tablet is
located on our website at https://junipersys.com/support/
mesa-3/my-product then Warranty. You can check warranty
status, view warranty terms and conditions, etc.

Standard repair orders and 3-Day Expedite Service repair
orders are valid for 30 days from the date issued. 1-Day
Expedite Service repair orders are valid for 7 days from the
date issued. If you will not be sending the product to us
immediately, please wait to request a repair until closer to
the fime when you are ready to send us the product.
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Services and Materials Provided Under Warranty
= Analysis of problem by service technician

» Labor and materials required to fix defective parts
= Functional analysis performed after repair
= Shipping costs fo return device to customer

JS strives to provide continued full repair services for our
products for up to five years from the final production

date of each product model. However, in some rare cases
(depending on the repair need), it may not be possible

to perform a repair due to an unforeseen discontinuation
or lack of supplied parts from third-party vendors. Repair
support for a product may continue beyond five years if
obtaining replacement parts or tools remains economically
feasible. Our policy is that we will do what is best and most
beneficial for our customers and company.

Complete Care Service Plans

We offer service plan options that provide additional
benefits through participating repair centers. Services
include:

= Service plan coverage up to five years from the original
product ship date
s Up fo a 50% discount on all charged repairs

» Expedited repairs and return shipping at no additional
charge

» Replacement of worn and/or damaged parts at no
additional charge

» Complete comprehensive coverage to protect your
investment even when accidents occur

= Loaner product option when an expedited repair is not
enough

Priority support through a personal account specialist

For more information about our Complete Care service
plans, go to our website at https://junipersys.com/support/
mesa-3/my-product then Warranty/Complete Care Options
or Warranty/Complete Care Terms and Conditions.
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Repairs, Upgrades, and Evaluations

@ CAUTION: Do not attempt to repair the Mesa 3 yourself. This

action voids the warranty.

Information about repairs, upgrades, and evaluations is
located on our website at https://junipersys.com/support/
mesa-3/my-product then Repairs. You can locate a repair
center, submit a repair order, check repair status, view terms
and conditions, get shipping instructions, and view lead
times.

Before returning a unit, please get permission by submitting
a repair order from our website and waiting for confirmation
or by contacting a repair center directly. Be prepared to
provide the following information:

s The product serial number. Information about your Mesa
3 is shown when you go fo the Start menu and select
Device Info. The serial number is located inside the
battery compartment as well.

Note: Before opening the battery door and removing the
battery, see the proper procedure in Chapter 2, Power
Management.

» Name and shipping address of company/university/
agency.
= Best contact method (phone, fax, email, cell/mobile).

= Clear, highly-detailed description of the repair or
upgrade.

» Credit card/purchase order number and billing address
(for a repair or upgrade that is not covered by the
standard warranty or an extended warranty policy).

System Information for your Mesa 3

You might be asked to provide additional information about
your Mesa 3 when you contact a repair center. To view
information like the operating system edition, OS build and
serial number, go to the Start Menu and select Device Info.
You can find additional information under Action Center
and select All Settings > System > About.
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Warnings, Regulatory Information,
Licensing

Product Warnings
Follow the warnings listed below to use the M3 (Mesa 3) and
accessories safely.

Battery Warnings

WARNING! This device comes with a lithium-ion
rechargeable battery pack. To reduce the risk of fire or
burns, do not disassemble, crush, puncture, short external
contfacts, or expose the battery pack to fire.

Do not disassemble or open, crush, bend or deform,
puncture or shred.

Do not modify or remanufacture, attempt to insert foreign
objects info the battery, immerse or expose to water or
other liquids, expose to fire, explosion or other hazard.

Only use the battery for the system for which it is specified.

Only use the battery with a charging system that has
been qualified with the system per this standard. Use of an
unqualified battery or charger may present a risk of fire,
explosion, leakage, or other hazard.

Do noft short circuit a battery or allow metallic conductive
objects to contact battery terminals.

Replace the battery only with another battery that has
been qualified with the system.

Use of an unqualified battery may present a risk of fire,
explosion, leakage, or other hazard.

Promptly dispose of used batteries in accordance with local
regulations.

Battery usage by children should be supervised.

Avoid dropping the battery. If the battery is dropped,
especially on a hard surface, and the user suspects
damage, take it to a service center for inspection.
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Improper battery use may result in a fire, explosion or other
hazard.

CAUTION: Risk of explosion if the battery is replaced by an
incorrect type.

Wall Charger Warnings
WARNING! To reduce the risk of personal injury, electrical
shock, fire or damage to the equipment:

Plug the wall charger into an electrical outlet that is easily
accessible at all times.

Do not place anything on the wall charger cord or any
of the other cables. Arrange them so that no one may
accidentally step on or trip over them.

Do not pull on a cord or cable. When unplugging the wall
charger from the electrical outlet, pull on the plug, not the
cord.

The AC wall charger must be approved by Juniper Systems,
have an output rating of 12 VDC and a minimum 1.67 A,
and be certified or listed by a nationally recognized testing
laboratory. The AC wall charger provided with the Mesa 3
meets these criteria. Using any other external power source
can damage your product and void your warranty.

Appendix C Warnings, Regulatory Information, Licensing 57



Certifications and Standards

There are North American, European Union, and Australian
versions of the Mesa 3, with different certifications and
standards.

United States

In compliance with the FCC rules 47 CFR 15.19(a)(3), the
statements that follow must appear on the device orin the
user documentation.

This device complies with Part 15 of the FCC Rules.
Operation is subject to the following two conditions:

s The device may not cause harmful interference.

= This device must accept any interference received,
including interference that may cause undesired
operation.

In compliance with the FCC rules, 47 CFR 15.105(b), the

user must be notified that this equipment has been tested
and found to comply with the limits for a Class B digital
device, pursuant to part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful
interference in a residential installation. This equipment
generates, uses and can radiate radio frequency energy
and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio
communications. However, there is no guarantee that
interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or
television reception, which can be determined by turning
the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following
measures:

= Reorient or relocate the receiving antenna.

= Increase the separation between the equipment and
receiver.

= Connect the equipment into an outlet on a circuit
different from that to which the receiver is connected.

= Consult the dealer or an experienced radio/TV
technician for help.

58 Mesa 3 Rugged Tablet Owner’s Manual



In compliance with the FCC rules, 47 CFR 15.21, the user
must be notified that changes or modifications to the
Rugged Tablet that are not expressly approved by the
manufacturer could void the user’s authority to operate the
equipment.

Only approved accessories may be used with this
equipment. In general, all cables must be high quality,
shielded, correctly terminated, and normally restricted
to two meters in length. Wall chargers approved for
this product employ special provisions to avoid radio
intferference and should not be altered or substituted.

Canada

In compliance with Industry Canada rules, the following
statement must appear on the device or in the user
documentation:

This Class B digital apparatus complies with
Canadian ICES-003.

This device complies with Industry Canada licence-exempt
RSS standard(s). Operation is subject to the following fwo
conditions: (1) this device may not cause interference, and
(2) this device must accept any interference, including
interference that may cause undesired operation of the
device.

Canadian regulations restrict the use of channels in the
band 5150 MHz to 5250 MHz to indoor use only. When this
product is connected with an access point that is operating
in this frequency range, or when using ad-hoc mode, the
use of this product is restricted to indoor use only.

Le présent appareil est conforme aux CNR d'Industrie
Canada applicables aux appareils radio exempts de
licence. U'exploitation est autorisée aux deux conditions
suivantes: (1) 'appareil ne doit pas produire de brouillage,
et (2) I'utilisateur de I'appareil doit accepter tout brouillage
radioélectrique subi, méme si le brouillage est susceptible
d’'en comprometire le fonctionnement.

La réglementation canadienne restreignent I'utilisation
des canaux dans la bande 5150 MHz & 5250 MHz pour une
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utilisation en intérieur. Lorsque ce produit est connecté
d un point d'accés qui fonctionne dans cette gamme
de fréquences, ou lorsque vous utilisez le mode ad-hoc,
I'utilisation de ce produit est limitée & une utilisation en
intérievur.

Radio Frequency Safety

This equipment complies with radiation exposure limits set
forth for an uncontrolled environment. This equipment is

in direct contact with the body of the user under normal
operating conditions. This transmitter must not be co-
located or operating in conjunction with any other antenna
or fransmitter.

Cet équipement est conforme aux limites d'exposition
aux radiations dans un environnement non contrdlé.
Cet équipement est en contact direct avec le corps
de I'utilisateur dans des conditions de fonctionnement
normales. Cet émetteur ne doit pas étre co-localisées
ou opérant en conjonction avec tout autre antenne ou
tfransmetteur.

CE Marking (European Union)
c Products bearing the CE marking comply with the EU
Directive 2014/53/EU.

CE compliance of this device is valid only if powered
with/by a CE-marked wall charger provided by the
manufacturer. Cables connecting to the USB host port must
use a ferrite core/bead on the cable. The ferrite core must
be placed on the cable near the end that connects to the
Mesa 3.

Declaration of Conformity
The Declaration of Conformity for CE Marking is available
at: http://www.junipersys.com/doc
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Restricted Materials Conformity
The Mesa 3 conforms to the following restricted materials
regulations:

= ROHS 2011/65/EU

= ROHS 2015/863

= REACH 1907/2006 (33)
= REACH 1907/2006 (67)
= POP 2019/1021

= Proposition 65

s Canada Prohibition
= TSCA

Licensing Information

This Product is licensed under the AVC, the VC-1 and the
MPEG-4 Part 2 Visual patent portfolio licenses for the
personal and non-commercial use of a consumer to (i)
encode video in compliance with the above standards
(“Video Standards”) and/or (i) decode AVC, VC-1 and
MPEG-4 Part 2 Visual that was encoded by a consumer
engaged in personal and non-commercial activity or was
obtained from a video provider licensed fo provide such
video. None of the licenses extend to any other product
regardless of whether such product is included with this
product in a single article. No license is granted or will be
implied for any other use. Additional information may be
obtained from MPEG LA, LLC. See www.mpegla.com.

No rights are given for Dolby patents used in the Dolby
portion of this product. A list of relevant patents may
be obtained from Dolby Laboratories, Inc. No rights are
granted to any Dolby copyrights, including the right to
reproduce or distribute any portions of this product that
includes Dolby intellectual property. Licenses for these
activities may be obtained from Dolby.

Any use of this product in any manner other than personal
use that complies with the MPEG-2 standard for encoding
video information for packaged media is expressly
prohibited without a license under applicable patentsin
the MPEG-2 patent portfolio, which license is available from
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MPEG LA, LLC, 6312 S. Fiddlers Green Circle, Suite 400E,
Greenwood Village, Colorado 80111 U.S.A.

Windows 10 is automatically updated, which is always
enabled. ISP fees may apply. Additional requirements may
apply over time for updates.

Cortana experience may vary by device.
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Mesa 3 Rugged Tablet Specifications
Note: Specifications are subject to change without nofice.

FEATURE

SPECIFICATION

Operating
System

= Microsoft® Windows 10 Pro or
Windows 10 loT Enterprise

= English, French, German, Spanish,
Brazilian Portuguese are built in;
other languages are available for
download

Processor

s Quad-core Intel® Pentium® N4200

Memory

= 8 GB RAM (LPDDR4)

Primary Data
Storage

= 128 GB or 256 GB flash storage
(model specific)

Micro SD/SDXC
Card Slot

» SD/SDXC slof, user accessible

Physical
Features

= Dimensions, standard: 5,4 wide x
8.48" long x 1.36" thick (137 mm x 215
mm x 35 mm)

= Weight: 1.510 2.2 Ib (680-907 g)
depending on battery configuration
and internal options installed

= Durable, chemical- and shock-
resistant design

» Easy-to-grip, impact-absorbing,
overmolded bumpers

= 3 mounting points on the back are
size #4-40 UNC with a maximum
depth of 3/16th” (4.76 mm)

Display

Active viewing area: 7" (178 mm)
WXGA 800 x 1280 pixel resolution
Backlit LCD

Outdoor viewable

Portrait or landscape orientation
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FEATURE

SPECIFICATION

Touchscreen

Capacitive multi-touch interface for
use with gloves, small tip stylus, and in
wet conditions
Chemically-strengthened
Dragontrail™ High lon-Exchange
(HIE™) coverglass for impact and
scratch resistance

Touchscreen profile options

Keyboard

Programmable keys
Backlit keys

Batteries

Rechargeable Li-lon battery pack,
7.2 VDC 6Ah, 43.2 Whr

Run time of up to 12 hours or more
Charging time 4 to 6 hours

Built-in battery intelligence
User-replaceable

Optional internal 21.6 Whr battery
provides an additional 50% of runtime
and hot-swap capability; not user
replaceable (not user accessible)

Connector Ports

USB 3.0 Host (full size A connector)
Power inputis 10V - 15.5V, nominal
12 vDC

3.5 mm audio jack, supports stereo
headset/microphone

Wireless
Connectivity

Bluetooth® wireless technology 5.0
long range

Wi-Fi 802.11 a/b/g/n/ac 2.4 GHz and
5 GHz

Audio

Mono speaker, loud and clear
Microphone, low noise

LED Activity
Indicators

Red: power applied/charging status
Green: system is booting

Blue: application programmable
Amber Light: front or rear facing
camera is in use
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Specifications

FEATURE SPECIFICATION
Standard = Ambient light sensor
Sensors/ » Compass
Features s Accelerometer
n Gyroscope
= TPM (Trusted Platform Module) v2.0
Temperature » Operating Temperature: -4°F to 122°F

(-20°C to 50°C).
Storage Temperature: -22°F to 158°F
(-30°C to 70°C)

» Battery Charging Temperature: 32°F
fo 122°F (0°C to 50°C)

Shock s Withstands multiple 4 foot drops to
Resistance concrete

Environmental » |P68 rating (1.4 meters for 2 hours),
Ratings and waterproof and dustproof
Standards » Designed to MIL-STD810G.

Tests:

ME-60: sand & dust

ME-51,53,& 54: X.Y,& Z-axis helicopter
vibe

ME-55, 56, & 57: X, Y, & Z -axis general
vibe

ME-52: Water Immersion, 1 meter
ME-59: Aggravated Temperature-
Humidity cycle

ME-67: Temperature cycle

ME-62: Temperature shock

ME-66: Altitude
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FEATURE

SPECIFICATION

Certifications
and Standards

FCC Class B

CE Marking

Industry Canada

Australia (ACMA)

Bluetooth SIG qualification

IP68 waterproof and dustproof
Designed to MIL-STD 810G

RoHS 2 compliant

Mesa 3 is certified on AT&T networks
MIL-STD-461F: Minimum Safe
Separation Distance Exceptions
HERO Unsafe: 10 ft (3 m)

HERO Susceptible: 5 ft (1.5 m)
HERO Safe: 1 ft (0.3 m)

Warranties

24 months for Mesa 3

90 days for accessories

Extended service and maintenance
plans
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Software on individual units may vary

FEATURE SPECIFICATION

Software Alarms & Clock

Included Calculator
Calendar
Camera
Cortana

Device Info (config/control)
File Explorer

Geode Connect
Groove Music

Keypad (config/control)
Magnifier

Mail

Maps

Messaging

Microsoft Edge
Narrator

OneNote

Photos

Snipping Tool

Sticky Notes

Store

Task Manager

Touchscreen Profiles (config/control)

Voice Recorder
Windows PowerShell

Windows Speech Recognition

from list based on the model
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FEATURE

SPECIFICATION

Configurations

All models and features for the Mesa
3 are configured for United States/
Canada, European Union or Australia.

Mesa 3 is offered in the following
models:

Base Model

Geo Model - With u-blox NEO-M8N
receiver and infegrated antenna
(optional upgrade: u-blox NEO-M8T
receiver with external antenna port)

The following configurations are
available for either model:

128 GB or 256 GB flash storage
8 GB RAM

Wi-Fi

Long range Bluetfooth wireless
technology

Front and rear facing cameras
4G LTE cell modem

Internal battery
Hot-swappable battery
Keypad (portrait or landscape)
Barcode scanner

RFID readers

Barcode scanner and RFID reader
RS-232 port (5V or 12V supply)

Camera

Resolution: 8 MP rear, 2 MP front
Auto focus

Video capture

JPEG image format

Flash
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FEATURE

SPECIFICATION

4G LTE Data
Modem

» Sierra Wireless AirPrime EM7455 or
EM7430 (region dependant)

= Supports micro-SIM card only. Micro-
SIM card header inside battery
compartment with card detect
feature and card retainer.

= Does not support voice calls or SMS

n Supports 3G UMTS, HSUPA, HSDPA,
HSPA, HSPA+, WCDMA, LTE

* See more details at the end of this
chapter

GPS/GNSS

= 2 to 5 meter typical accuracy

n U-blox NEO-M8N GNSS receiver and
integrated antenna

» Infegrated real-time SBAS receiver
(WAAS, EGNOS, etfc.)

= 72 GNSS tfracking channels

= Optional upgrade: u-blox NEO-M8T
with post-processing data output and
external GNSS antenna connection
for sub-meter accuracy

UHF RFID

= Optional built-in UHF RFID module
and antenna

= Region-specific frequency
configurations (859-873 MHz & 915-
930 MHz)

s EPCglobal Gen 2 (ISO 18000-4C)
protocol support

= Wide output range (0 dBm to +27
dBm)
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FEATURE SPECIFICATION

Barcode 1D/2D |w» Imager and Decoder: Motorola/

Imager Symbol SE4710 imager and PL3307C
400 MHz decoder

= Sensor Resolution: 1280 x 800

» Field of View: Horizontal 42°, vertical
28°

» Reading Angles: Skew & pitch £60°,
roll 360°

s Read Range: 1" to 24" depending on
code type, size, and density

= Aiming dot: Visible with low light
illumination

= Symbologies: All common 1D, 2D
(PDF417, MicroPDF417, Composite, RSS,
TLC-39, Data matrix, QR code, Micro
QR code, Aztec, MaxiCode, Postall
codes, etc.)

» Trigger Buttons: Programmable

» Barcode Connector™ Utility: Wedge
and configuration

= Power: 1.49 W active, 0.54 W standby,
8 mW sleep; by default device returns
to sleep after 1 second of inactivity

RS-232 m RS-232C 9-pin D-sub connector
= Hardware option for either 5V @ 600
mA or 12 V @ 390 mA available on

pin 9 (ring in)
Standard = Removable Li-lon battery
Accessories » Adjustable hand strap
s AC wall charger with international
plug kit

- Input: 100-240 VAC, 50/60 Hz, 0.8 A
- Output: 12VDC, 2.5 A

Capacitive fine tip stylus with tether
Quick Start Guide

Owner’'s Manual (on our website)
Two year warranty on Mesa 3

Appendix D Specifications 71




FEATURE

SPECIFICATION

Optional
Accessories

» Infernal extended battery, 7.2V @ 3
Ah, 21.6 Wh Li-lon

» Integrated UHF RFID Reader and
Antenna

» Infegrated RS-232 9-Pin, D-Sub
Communication

= U-blox NEO-M8T GNSS receiver and

external antenna connection

Survey/GPS pole clamp and mount

Pistol Grip for reading barcodes

Holster for Pistol Grip and Mesa 3

Vehicle charger cable, 12 V vehicle

power port, 6 f1.

= Vehicle Mounting Dock with 12 VDC
power port, vehicle charger, and USB
port

= Vehicle Dock/Pole mount - dock
attachment

» Office Docking Station with power/
charge input, HDMI output, 3 USB 2.0
(full size A), Ethernet

s AC wall charger, 45 W

- includes cord with U.S. plug

- Input: 120-240 VAC, 50/60 Hz

- Output: 12VDC, 3.75 A

Travel charger

Shoulder strap

Serial cable

Holster carrying case

Flip cover fitted case

4-point harness

SD cards in various sizes

Screen protector (anti-glare, ultra-

clear, or polarized)

n Office 365
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* 4G LTE Data Modem - Additional Information

Mode Model/Region Frequency Bands
LTE North America/EU/ROW B1, B2, B3, B4, B5, B7, B8, B12,
B13, B20, B25, B26, B29, B41
N Australia B1, B3, BS, B7, B8, B18, B19,

B21, B28, B38, B39, B40, B41
UMTS/HSPA+ North America/EU/ROW | B1, B2, B3, B4, B5, B8
“ Australia B1, B5, Bé, B8, BY, B19

Note: ROW = Rest of World, or Non-North America
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4G Data Modem
Data Account, Set up With Wireless Provider 22
SIM Card Installation 22

A
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Audio Features 12
Audio Jack 12
Microphone 12
Speaker 12

Barcode Connector Utility 23
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Barcode Connector Utility 23

Pistol Grip 28

Holster 28

Sample Barcodes 26-27
Battery Compartment 3, 4
Battery Door 2-3
Battery Pack, Internal 15-16
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Battery Life 15

Charge 5, 15, 51

Install 4-5
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Storage 40

Warnings 50
Bluetooth Wireless Communication 13-14
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Specifications 62
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Storage 40
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Cleaning 41
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Task Manager 17

D
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Geode Connect 21
Geo Model 20, 22
GPS/GNSS 20, 63
Geode Connect 21
u-blox NEO-M8T GNSS Receiver 20

H
Hand Strap 6

K

Keypad
Backlight Brightness 10
Key Functions 9
Programmable Keys 9

L
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Light Sensor 11

Limitation of Liability 46
Locked Up 17

M

Memory 58
Microphone 12, 59
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Office Docking Station 34
Operating System 58
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Pistol Grip 28
Holster 28
Powering Off 16
Product Warnings 50
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Recycling the Mesa 2 and Batteries 41
Removable Battery Pack 3-5
Repair 48

System Information 48
Repairs, Upgrades, and Evaluations 48
RFID Reader 29
RS-232C Port 32

S

Screen Protector 65
SD Cards 11
Sensors
Accelerometer 13
Compass
Calibration 13
Gyroscope 13
Service Plans 47
Set up Tasks, Initial 4
SIM Card 3, 23
Software Included 61
Speaker 2
Specifications 58-65
Storing the Mesa 2 16, 40
Stylus 3, 6
Stylus Storage Slot 2
Tether 6
System Information 48

-

Task Manager 17
Temperature Specifications 60
Touchscreen 8-10
Calibration Tool 9
Protecting the Touchscreen 40
Settings 8
Specifications 59

U
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Vehicle Dock 37
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Wall Charger 5, 15, 51
Warnings 50-51
Battery Warnings 50-51
Wall Charger Warnings 51
Warranty 44-47
Exclusions 44
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